The purpose of this tutorial is to instruct any ecologist (and specifically the person who initiated this project) in the elevation zone altitude calculation procedure recently developed for an NCEAS associate’s long-term diversity research study. This report will also educate other life scientists in the issues surrounding selection of digital spatial datasets and geoprocessing software tools. However, the general topic of geoprocessing tool selection may be the topic of a separate, more comprehensive report at a later date.

I. Overview

This project was initiated in response to a request by NCEAS Postdoctoral Fellow Christy McCain, who wishes to compute, for 46 worldwide study sites, the percentage of each site area falling within a series of 100 meter ‘wide’ elevation zones. For example, the percentage of the site between 100 – 200 meters, 200 – 300 meters, etc. The lower bound for the first elevation zone and upper bound for the last elevation zone will be each study site’s minimum and maximum elevations, respectively. The output product produced for each study site is a table, in ASCII comma-separated value format, with these values:

- Total study site area (meters ** 2)
- The minimum and maximum altitudes defining each elevation zone
- The total site area (meters **2) falling within each elevation zone
- The percentage of total site area falling within each elevation zone

The primary data source for this study is Digital Elevation Model (DEM) data compiled for most parts of the Earth, typically by government mapping agencies. Several alternate sources of DEM data have emerged over the past decade; selection of a source depends upon several criteria. DEM data sources and the criteria used in selecting the best source for a given application are described in the next section. The DEM data for all sites were obtained free of charge over the Internet, from various sites administered by the United States Geological Survey (USGS). We used ESRI’s ArcMAP GIS Version 9.0 Geographic Information System software to process the DEM data, compute the elevation zone areas, and display all DEM data and classification maps.

This project is an excellent case study of using geospatial data to gain insight into an ecological study area. Two reasons for this are:

1) The source data, digital elevation models, are straightforward and the output product derived (elevation area statistics) are simple to understand and relate to one’s own fieldwork.
The project workflow is representative of many geospatial data projects in that it consists of many simple-to-understand spatial processing operations, which, when considered as a group, become complicated enough to reveal the need for specialized geoprocessing software (e.g., a GIS package).

Therefore, this tutorial will be useful to any life scientist interested in incorporating any type of digital spatial data (e.g., DEMs, maps, satellite photos) into their projects. For this reason we expand slightly the discussion of software tool selection to consider alternatives to the full-featured GIS package that we selected for this particular project.

II. Elevation Zone Area Calculation Project Phases

The complete effort to calculate elevation zones areas for these study sites has four phases:

- Data source evaluation and selection
- Software tool evaluation and selection
- Spatial data processing workflow design
- Production of final elevation zone area images and tables

**Phase 1: Evaluate and select Digital Elevation Model (DEM) Data Source**

To compute elevation zone areas, you will need digital elevation data and software to organize and display the data and perform the calculations. Several alternative data sources and software tools are available.

**Digital Elevation Data:** The main source of worldwide digital elevation data are Digital Elevation Models (DEM) available through various divisions of the United States Geological Survey. DEM data are arrays of regularly spaced elevation values referenced horizontally either to a Universal Transverse Mercator (UTM) projection or to a geographic coordinate system. The grid cells are spaced at regular intervals along south to north profiles that are ordered from west to east. The terrain elevations that are the source for all DEMs are derived from topographic map data or, increasingly, data from air- or space-borne imaging sensors.

DEM data have been available to the civilian research community for sites the continental United States since the early 1980s. Until relatively recently, worldwide data was classified and available only to military and defense agencies and civilian contractors working on defense contracts. Within the past decade, unclassified, worldwide DEM data has become available to the general public. Driving this trend has been the launch of high-resolution commercial remote-sensing satellites and NASA-sponsored space imaging programs, all of which collect DEM data. In addition, the United States military mapping agencies have declassified some worldwide DEM data sets. Most of these DEM data are available at low- or no-cost to the research community, and can be obtained over the Internet.

The Web site www.terrainmap.com presents a comprehensive introduction and overview of DEM data concepts and sources, including links to the best sources for each data product.
During Phase 1, we identified four DEM data products which, combined, supply the DEM data required for all of Dr. McCain’s study sites:

**GTOPO30:** Global 30 Arc-Second Elevation Data Set (GTOPO30) is a global raster Digital Elevation Model (DEM) with spatial resolution of approximately 1 kilometer (30 arc seconds). GTOPO30 was derived from a variety of raster and vector data sets. These data are available for almost all land areas; however, the coarse spatial resolution reduces the accuracy of the elevation calculations. Therefore, GTOPO30 data are used only when no other DEMs are available for a site. Consult [http://eros.usgs.gov/#/Find_Data/Products_and_Data_Available/GTOPO30](http://eros.usgs.gov/#/Find_Data/Products_and_Data_Available/GTOPO30) for complete product specifications.

**1-Degree (1:250,000) USGS DEMs:** The United States Geological Survey produces five types of elevation data, which are described at [http://eros.usgs.gov/#/Find_Data/Products_and_Data_Available/DEMs](http://eros.usgs.gov/#/Find_Data/Products_and_Data_Available/DEMs). We have selected the 1-degree data for this project because its resolution is appropriate for the core elevation zone calculations and because they match the resolution for the other data sources.

**Shuttle Radar Topography Mission (STRM):** was flown aboard the NASA Space Shuttle Endeavour February 11-22, 2000. SRTM utilized dual *Spaceborne Imaging Radar* (SIR-C) and dual X-band *Synthetic Aperture Radar* (X-SAR) instruments to acquire two simultaneous images that, when combined, can produce a single 3-D terrain image., SRTM successfully collected data over 80% of the Earth’s land surface, for most of the area between 60 degrees North and 56 degrees South latitudes. The spatial resolution of these data are approximately 30 meters (1 arc second) for the continental United States and approximately 100 meters (3 arc seconds) for the rest of the globe. The absolute horizontal and vertical accuracy is 20 meters (circular error at 90% confidence) and 16 meters (linear error at 90% confidence), respectively. Consult [http://www2.jpl.nasa.gov/srtm/](http://www2.jpl.nasa.gov/srtm/) for complete product specifications.

**ASTER Digital Elevation Models:** ASTER Digital Elevation Models are generated from a pair of images from the ASTER multi-spectral remote sensing satellite. ASTER (Advanced Spaceborne Thermal Emission and Reflection Radiometer) is an imaging instrument that is flying on *Terra,* a satellite launched in December 1999 as part of NASA’s *Earth Observing System* (EOS). ASTER DEMs have a spatial resolution of 30 meters and are available for potentially any land area on the globe. ASTER DEMs are produced only upon customer request; however, the research community can submit On-Demand Processing Requests for any worldwide location. The continually growing archive of these products are available to the research community via the Land Processes Distributed Active Archive Center: [http://edcdaac.usgs.gov/aster/asterdataproduct.asp](http://edcdaac.usgs.gov/aster/asterdataproduct.asp)

Consult:
http://asterweb.jpl.nasa.gov/content/03_data/01_Data_Products/release_DEM_relative.htm

…for a description of ASTER DEM products.

These are the data portals used to obtain the DEM data models described here:

The USGS digital elevation model product portal:
http://eros.usgs.gov/#/Find_Data/Products_and_Data_Available/DEMs.

Search for and order GTOPO30 data at:

Search for and order 1 and 3 arc-second USGS DEM datasets via the National Map Seamless Data Distribution System:
http://eros.usgs.gov/#/Find_Data/Products_and_Data_Available/NED.

Search for and order SRTM Data at:
http://www2.jpl.nasa.gov/srtm/

Search for and order ASTER Data via the EOS Data Gateway:
http://asterweb.jpl.nasa.gov/data.asp

**Phase 2: Spatial Data Processing Software Tool Selection**

*Spatial Data Processing Tools:* Digital Elevation Models are essentially 2-dimensional matrices of elevation data depicting topographic conditions for a rectangular area of the Earth surface. They are typically processed with one of three types of software: Some researchers use mathematical software packages such as Matlab, SAS, or S-Plus. These analysis packages handle matrix data efficiently and perform many standard mathematical and statistical functions.

Some operations require specialized spatial algorithms, for example, spatial autocorrelation, that are not supported by the standard packages. The better products offer optional extensions that include specialized spatial processing, such as the Matlab Image Processing Toolbox or the S-Plus Spatial Statistics add-on.

Even these enhancements may not be sufficient. Two cases: when large spatial datasets must be combined or 'mosiaced' into larger images. Or when the researcher needs to produce spatial overlays, or needs to produce a map image of the study area. In this case, a full-scale Geographic Info System may be the best alternative. GIS packages typically include utilities that convert the specialized DEM data formats into and out of the package’s specialized raster data model. In addition, most GIS packages include geoprocessing utilities that sample, analyze, and display raster datasets such as DEMs.
There are many Geographic Information Systems packages, with a wide range of feature sets and capabilities, available from commercial software vendors, ‘open source’ software consortiums, and government agencies. It is beyond the scope of this tutorial to survey all (or even a few) of the available technologies and products. However, the following Internet resources give the interested user a starting point from which to begin learning about GIS

NCGIA Core GIS Curriculum:
http://www.geog.ubc.ca/courses/klink/gis.notes/ncgia/toc.html

Okanagan University College / Introduction to GIS (with other web links)
http://www.physicalgeography.net/fundamentals/2f.html

Geographic Information System entry from Wikipedia
http://en.wikipedia.org/wiki/GIS

Geocomm.com – Information clearinghouse for GIS and mapping software:
http://software.geocomm.com/

No single GIS product will satisfy the requirements of all users or project specifications. Therefore, prior to selecting a GIS product for a specific project, the scientist must:

1) Carefully review his or her project’s GIS-specific processing requirements,

2) Determine the amount of time and project budget that are available for use in acquiring and gaining sufficient skill with the GIS system to complete the project,

3) Develop a ‘short list’ of candidate GIS systems whose feature sets satisfy the project’s analytical, data, and user training requirements,

4) Select, acquire, and gain proficiency with the selected GIS before beginning the actual project work.

The following textbook provides a comprehensive introduction to Geographic Information Systems, and includes a detailed discussion of the GIS selection process:

http://wps.prenhall.com/esm_clarke_gsgis_4/

ESRI’s ArcGIS Version 9.0 was selected by the Dr. McCain and the NCEAS Scientific Computing team for this project. Four reasons drove this choice:

1) The ArcMap GIS feature set includes the aforementioned raster processing tools that are key to this project. This toolset can be expanded by adding custom special processing tools required for the analysis. In fact, we had to develop and add two custom processing tools to ArcMap GIS in order to complete this project.

2) The raster DEM data required for the project is available in ArcMap GIS - compatible format.
3) Dr. McCain already has experience with ArcMap GIS, and wished to expand her knowledge of the product.

4) The NCEAS Scientific Computing team wished to ‘use-test’ the latest version of Arc Map GIS using an ongoing, ‘real-world’ project.

However, if ArcMap GIS was unavailable or otherwise unsuitable for this project, several available alternatives would be considered: MATLAB, S-Plus, or an open-source GIS (e.g., GRASS) or statistical packages (e.g., R) all include raster data processing and/or geoprocessing tools could be used to conduct the analysis and produce the final output products.

**Phase 3: Develop DEM data processing and classification workflow**

After the DEM data source(s) have been identified and processing tools selected, we developed the individual geo-processing steps and workflow for transforming the raw DEM data for a site into an elevation zone area estimate. The sequence has seven steps, depicted in Figure 1. Section III, below, describes each processing step in greater detail, in terms specific to the data sources and software tools selected for this project.

**Elevation Zone Calculation Process Steps**

1) Configure the ArcMAP GIS environment to perform the project.
2) Identify and obtain the best DEM data source for site.
3) Convert DEM files to ‘GIS software-compatible’ data format.
4) Create DEM image covering site region.
5) Re-Project the site region DEM image into correct map projection.
6) Create (clip) DEM sub-image exactly matching site boundary.
7) Classify site into elevation zones.
   a. Create site-specific Elevation Zone lookup table
8) Use Area Calculation Utility to compute Elevation Zone Area table.
Figure 1
Workflow: Producing Elevation Zone Maps for Study Sites using DEM data

Phase 4: Organize processing and production environment for each study site

Once the data processing techniques have been developed and tested on one or more selected study sites, it is best to set up a production environment in which to perform the analysis on the set of remaining study sites. This environment consists of: 1) a standardized file system to systematically manage (e.g., procure and store) the data for all of the study sites, 2) a production checklist or software script to assure that each site is processed identically and completely, and 3) Quality Assurance procedure to ensure error-free results, and a means of archiving the results.

This systematic approach is mandatory for the current project due to the large number of potential sites (50) and the size and possible number of component data files for each site (for example, if DEM mosaics are necessary). We defined one folder per test site, with each site containing an additional subfolder for each DEM data type. Then, we developed the processing workflow described above. Finally, we researched the ArcGIS Version 9.0 ArcMap features required to perform the analysis. This research revealed the need to develop two custom tools: a ‘point picker’ tool, enabling the user to
identify the latitude/longitude for points in the DEM using the mouse; and, a utility to calculate the area of each elevation zone in the classified DEM image.

III. Classification Procedure Overview

1) **Configure ArcMAP GIS software environment: Add custom processing tools**

ArcMAP GIS is a comprehensive software package; however, users sometimes need to augment the standard features with project-specific tools. The elevation zone area calculations require two geoprocessing tools which are not part of the ArcMAP GIS Spatial Analysis toolkit: A tool for finding the latitude and longitude for any point on the DEM image, and a utility for computing the elevation zone areas. The ArcMAP GIS software is extensible; that is, users can write custom processing functions in a standard scripting language (Visual Basic for Applications), and add them to the standard software feature set through the graphical user interface. We will demonstrate in detail the technique for doing this in Section IV.

2) **Identify and obtain the best DEM data for the site**

Evaluate the location and size of the study area. Determine the spatial resolution that you require for your analysis. For the current study, we selected the 3 arc-second (100 meters) for use in all test sites (data availability permitting) as this resolution captures key terrain detail while maintaining reasonable DEM file size. DEM data at 1 arc-second (30 meter) resolution is available for some parts of the United States; however, these DEM files are 3 times larger than the 3 arc-second files, and are not available for worldwide locations. For very large test sites (e.g., the island of Madagascar) or sites for which 3 arc-second data was not available, we used 30 arc-second, GTOPO30 digital elevation models.

As mentioned above, the United States Geological Survey (USGS) is the primary clearinghouse for worldwide digital geographic data. These are the Web portals for exploring and obtaining DEM datasets from United States Geological Survey sources.

3) **Convert DEM file(s) into ‘GIS software-compatible’ data format.**

After obtaining the appropriate DEM data product for the site, transform it into a geographic raster database compatible with the processing software that you have selected (for this project, this is ArcMAP GIS Version 9). When downloading select one of these two formats: Native DEM, which is a standard format recognized by many analytical software programs, or ARC/ESRI Grid, the native ArcMap GIS format, which is also recognized by many other analytical and GIS software programs.

As a rule of thumb, it is wise to order enough data to provide a 25% overlap surrounding all dimensions of your study site. For example, for a study site 10 miles in diameter, order sufficient DEM data to provide a 2.5 mile border on all sides of the site. Reason: to provide a margin of error when clipping the DEM image, and to provide a visual context for the study site’s setting in its larger physical environment.
The final step in the data acquisition process: If the DEM data files that you obtained are not in the format compatible with the analytical software that you are using, use the appropriate software utilities to convert them to the native format. Keep in mind that many non-GIS analytical software packages can read the Native DEM data format. Other software packages require that the DEM files be converted to a simple, 2-dimensional binary array file format.

4) **Create single DEM image completely covering site region**

Some study sites may be large enough in area to require that several individual DEM datasets be combined into a larger, single DEM file in order to cover the entire site with a contiguous elevation map image. Such an image is known as a **DEM Mosaic**. The biggest technical challenge faced when creating a mosaic image is properly interpolating (smoothing) the boundary areas where the individual image ‘tiles’ join. For this reason image mosaics are usually produced using specialized raster processing features of GIS software packages.

As noted in **Step 2**, this single DEM image should contain the study site with a 25% overlap on all sides.

5) **Transform the site DEM image into correct map projection.**

The next step is to transform the DEM mosaic image into a map projection that preserves spatial relationships within the test site so image feature areas have the correct size with respect to one another and so that map distance and area is measured in the correct units (typically meters). To do this, we will use ArcMAP GIS Map Transformation Library and Raster Project utility.

6) **Extract image subset exactly corresponding exactly to the study site**

The next step is to extract, if necessary, a subset of DEM image corresponding EXACTLY to the site boundaries. This creates a DEM sub image whose area matches the area of the study site. There are three possible cases that dictate which processing method will create the desired image:

a. If the study area is an island surrounded by water, image extraction is unnecessary; simply exclude from the area calculations any image cells with a value less than 1.

b. If the study area is a circular or polygonal (e.g., square or rectangular) region surrounding a specific latitude/longitude pair, then use the specialized ‘raster clipping’ feature found in most GIS programs to extract the sub image.

c. If the study area is an entire country, then it will be necessary to obtain a data file containing a geographically-referenced outline of the country, which is then used as an alternative input to the raster clipping feature in the GIS package.

The specific method steps for extracting a sub image from a larger image is a function of the software tools being used. The steps used within ArcMap GIS are demonstrated in Section IV, below.
7) Classify the site DEM into elevation zones

First step is to **Create Elevation Zone list matched to site altitude range.** Obtain the minimum and maximum elevation values for the site image created in the previous step. Then, develop the desired set of elevation zone thresholds, which span this range of elevations. For example, if the minimum and maximum elevations for a site are 95 and 510 meters, and the research dictates 100 meter ‘wide’ elevation zones, then one possible set of thresholds is:

- 95 – 200 meters
- 201 – 300
- 301 – 400
- 401 – 510

Then, enter this set of thresholds into a table or file compatible with the classification method to be used to generate the elevation zone map (Step 6).

Use the table created in Step 5, and the appropriate raster classification feature of the analytical / GIS software package, to create a new image of the study site in which the individual elevation pixel values are converted to class membership values. For example, using the above four zones, site map pixels with values of 105 and 509 have values of (class #) 2 and 4, respectively, in the output classified image. The image classification steps used within ArcMap GIS are demonstrated in Section IV, below.

This step usually produces a secondary output table containing the total number of image pixels and the number of image pixels belonging to each elevation class. We will use this table in **Step 7**, below.

8) Use Area Calculation Utility to compute Elevation Zone Area table

The final step in this procedure is to compute the area (in map area units) of the study site belonging to each elevation class. The input to this step is the secondary ‘pixel count’ output table from **Step 6**. The output is a second table containing the area statistics for each class. The area computation method used is a function of the analytical software selected. The technique used within ArcMap GIS is described and demonstrated in Section IV, below.

IV. Case Study: End-to-End classification for one test site

The Olympic Peninsula site was selected for the case study because it enables us to explore all of the data sources and demonstrate all of the data processing features that must be used to complete this study for all of the test sites. For example; all of the DEM data sources are available for this site, so their accuracy and size can be compared. Also, the Olympics test site is defined (as are several others) as a 50 kilometer (radius) circle around a single latitude/longitude point, thus requiring the complete set of ArcMap GIS geoprocessing features required for the project.

Prior to beginning this project, we suggest creating a project folder hierarchy that contains one sub-folder for each test site. We use the following hierarchy in this tutorial:
Following are detailed descriptions of each workflow step, as implemented with the ArcMAP software and the data selected for the test site.

1. **Configure ArcGIS 9 software with project-specific processing tools**

   We will use two components of *ArcGIS Version 9* to process the DEM data for the test site: *ArcCatalog*, and *ArcMap*. ArcCatalog helps the user to manage spatial data files within the ArcGIS environment. ArcMap is the comprehensive application that includes spatial data development/handling, spatial analysis, and map display functionality. Typically we use ArcCatalog to import spatial data into the ArcGIS environment and, if necessary, to convert or reformat the data. We use ArcMap to perform the bulk of required spatial analysis, and to generate map display products.

   To expedite area calculations for the 46 sites in Dr. McCain’s study, we developed two custom software utilities: The first enables the user to obtain the latitude and longitude of any point on a projected raster image using the mouse; the second computes the area in map units (e.g., meters **2) of the classified elevation zones. Per the convention for most extensible Microsoft Windows products, the utilities are added to the ArcMAP graphical user interface as toolbar button ‘controls’. Here are two main steps to adding such controls: First, create the new control and add it to the user interface. Then, ‘connect’ the control to the actual software module that performs the operation. We will add two different controls to the user interface: A *UI Tool Control* for the latitude / longitude point finder, and a *UI Button Control* for the elevation zone area calculator. Following is the procedure:

   **Adding new controls to the User Interface toolbar:**

   Overview: Add two custom User Interface controls to the *ArcMap* Spatial Analysis toolbar and connect them to the corresponding software modules:

   A. Copy the file *ArcMapDEMControls.txt* into the root folder of your project file system (e.g., *C:\Projects\ChristyMcCain\TestSites*).

   B. Start *ArcMap GIS*, Select File> New> Blank Document to create a new map workspace (‘document’). Select View> Toolbars, and search/scroll down to the *Spatial Analyst* toolbar entry. It there is not a check mark beside the entry, left-click the entry to add it to the main UI toolbar collection. You will add the two new controls to this toolbar.

   C. Select *Tools > Customize* to open the *Customize* dialog box.

   D. Click the *Commands* tab.

   E. In the *Categories* list box Scroll down and select *UiControls*.

   F. From *Save in*: dropdown menu, select *Normal.mxt* to add these controls to your default ArcMap map template. This makes these new controls
available for addition to the other map documents that you will be creating.

G. Click the **New UI Control..** button, then select the **UIButtonControl** radio button.

H. Click the **New UI Control..** button, then select the **UIToolControl** radio button. The **Command** window now shows two new controls: **Normal.UIButtonControl1**, and **Normal.UIToolControl1**

I. Double Left-click the **Normal.UIButtonControl1** control. This opens a new, document named **normal.mxt – This Document** in a Visual Basic session. The document may be empty, or it may contain Visual Basic source code for other UI controls already installed. You will add to this file the source code for two new Visual Basic functions: **UIToolControl1_MouseDown**, and **UIButtonControl1_Click**. Copy the entire contents of the file **ArcMapDEMControls.txt** into ‘This Document’. Note: If this file contained earlier versions of either of these two functions, be sure that they are REPLACED by the latest versions. Select **File/Save normal.mxt** and close the Visual Basic session.

J. Again, select **Tools > Customize** to open the **Customize** dialog box. You should see the two new controls in the **Commands** window.

K. Select/left-click the **Normal.UIButtonControl1** control with the mouse, and drag it up and over to the **Spatial Analyst** section of the toolbar collection. A small button icon should appear. Repeat this process with the **Normal.UIToolControl1** control. A small tool control should appear. Close the Customize window.

L. When you create a new map document for each test site DEM, add these new controls to each one using the **Tools > Customize** option.

2. **Identify and obtain the best DEM data source for site:**

   The Olympic Peninsula site is formally defined as a circle with 50 km radius centered on the geographic coordinates: 47.54 North latitude, 123.58 West longitude. All of the DEM data sources described in **Section II** provide coverage of this site. Recall from Section II that we selected 3 arc-second (nominally 100 meter) as the most suitable spatial resolution for this study. Given this selection, the most suitable DEM source for this site is the 1 degree, 1:250,000 scale USGS DEM, available from the USGS at:

   [http://eros.usgs.gov/##/Find_Data/Products_and_Data_Available/DEM](http://eros.usgs.gov/##/Find_Data/Products_and_Data_Available/DEM)

   **Download DEM data covering site region**

   The Olympic Mountains test site is a circular area with diameter of 100 km centered on coordinate 47.54 N / 123.58 W. We need to download enough DEM data to include this site with a 25 % overlap on all sides. Each 1-degree DEM contains approximately 1200 rows and 1200 columns, covering an area approximately 100 kilometers on a side (will vary as a function the site latitude) To determine the size of the DEM needed to adequately cover the study area:
100 km = 100,000 meters / 100 meter spatial resolution = 1000 rows and 1000 columns. Add desired 25 % overlap on all sides: 1500 rows and 1500 columns, centered on the site coordinate.

Note that the coordinate pair is at the upper left corner of a 1-degree square, placing it close to the intersection of four 1 degree, 1200 row/1200 column DEMs. Creating a mosaic of these four images results in a 2400 row, 2400 column DEM, exceeding the minimum overlap defined in the previous paragraph. Therefore, we should download the corresponding four 1 degree datasets from the USGS DEM site (above).

Click on the above link, select the Search and Order option, then the 'One Degree DEMs (1:250,000) – USGS Geographic Data Download' link. Then, select the (Data Sets:) 1:250k DEM option from the menu bar on this new page, then the ‘FTP via graphics’ option. This will display an index map of the United States (Figure 2). Focusing on the Olympic Peninsula (Washington State) area click on the center of the 3 degree by 2 degree Cascade Range map sector (Figure 3). Each of these named cells represents one DEM dataset pair (East and West components). The Olympic site point is located at the intersection of the Cape Flattery, Victoria, Copalis Beach, and Seattle sectors. For good measure, we will create a mosaic using the following six DEMs:

- Cape Flattery West
- Victoria East
- Victoria West
- Copalis Beach East
- Seattle East
- Seattle West

To download each DEM, double click the desired index map cell. Select the compressed file option for that map cell, clicking on the `<file name> -- compressed` (Figure 4). Place the files into appropriate directory in the file structure that you created (e.g., TestSites\Olympics\CapeFlatteryWest), and use the gzip or WinZip utilities to decompress the files. The uncompressed files are in the standard, DEM data format; however, you will need to manually add the ‘.dem’ suffix to each file after is has been extracted from the archive.
Figure 2: USGS 1: 250,000 / 1 degree DEM index map
Figure 3: Index Map for Olympic Test Site Region

You can retrieve the following files in either compressed or uncompressed form. The uncompressed files are about 9 megabytes. Compressed files vary from about 100,000 bytes to 2 megabytes and require the gunzip program to uncompress.

- Seattle East -- uncov
- Seattle East -- comp
- Seattle West -- uncov

Figure 4: Seattle 1 degree DEM file download dialog
3. Convert files to data format

These .dem files are the raw material from which we will create the dataset used in the Elevation Zone area calculations. To display them and make them useful for our analysis, we need to: 1) convert each .dem file into an ArcMap raster dataset; 2) transform the data into a map projection with the appropriate spatial relationships; for example, distance units and raster cell (pixel) size. For a good introduction to this topic, open ArcMap GIS help, and use the phrase: ‘About Coordinate Systems and Map Projections’ as search criteria. Use the ArcToolbox utilities within the ArcCatalog component of ArcGIS 9 to convert the files. Following are the steps:

From ArcToolbox, select Conversion Tools/To Raster/DEM to Raster. This utility generates an ArcGIS raster database, consisting of multiple individual files, from the input .dem file. For the input USGS DEM file, select the name of the .dem file you wish to convert. For the output raster file, specify the pathname of the folder where you wish the utility to store the output dataset files. The dataset will be known (within ArcMAP) by this name. Select INTEGER as the output data type and 1 for the Z factor (Figure 5). Click OK to convert the file. If the conversion is successful, the resulting dataset will automatically appear in the Table of Contents (far left window) as a layer, with the name that you specified.

![Figure 5: ArcMapGIS DEM to Arc Raster Data Format Converter](image)
4. Create DEM image completely covering site region Since the test site is large with respect to the size of the DEM datasets, we must join several DEM datasets together in order to produce an image that completely covers the site. We do this by creating a **mosaic** using a collection of DEM datasets.

First, we need to create an empty raster dataset calibrated to accept 16 bit integer values, the natural datatype for elevation values. In ArcMap GIS, use **Data Management Tools / Raster / Create Raster Dataset** to generate an empty raster dataset with 16 bit unsigned values. In the Output Location dialog, specify the root folder for this test site. Also supply a output raster dataset name; this will be the name of the mosaic raster image. Leave the **Cellsize** field blank. For the **Coordinate system**, repeat Step 3, Part B above, to select the same projected coordinate system selected for the individual projected DEM files. Select 16 BIT SIGNED as the **Pixel type**. Leave Number of Bands as 1. Do not use the ArcSDE geodatabase parameters (Figure 6).

Next, create the mosaic using the **ArcMap Raster Mosaic** utility: From ArcToolbox, select **Data Management Tools / Raster / Mosaic** Use the
dropdown menu to construct the list of *projected* raster datasets that comprise the mosaic. For the Target Raster, navigate to the Personal Geodatabase that you created and select the empty raster dataset. For the Mosaic Method, select **Blend** (Figure 7). Use the defaults for the other fields. Press OK to create the mosaic. NOTE: At this writing, the Raster Mosaic utility did not always run successfully under **ArcMap**. In the event that the **Raster Mosaic** function fails within **ArcMap**, try the same function within the **ArcCatalog** software's ArcToolbox library.

**Figure 7**: ArcMap GIS **Mosaic** Dialog: Generating the Olympic Test Site DEM Mosaic
5. Re-Project DEM Site Image into appropriate map projection

The next step is to spatially transform the DEM mosaic image so that the area relationships between image features are maintained correctly and that map distance is measured in appropriate units. To do this, we will transform the DEM image into the correct map projection. From ArcToolbox, select Data Management Tools/Projections and Transformations/Raster/Project Raster. Specify the name of the dataset produced in the previous step. For the output raster file, specify the pathname of the folder where you wish the utility to store the projected dataset files. Select BILINEAR for the resampling technique. Leave the Output cell size field blank.

Selecting the best map projection for a specific application requires some knowledge of the issues and tradeoffs associated with the many map projections. We need to transform the DEM data into a projection that uses meters as a distance unit, while preserving the relative areas of features (for example, elevation zones) in the map. One map projection that meets these requirements is the Albers Equal Area Conic projection. To select this, press Select…, then Projected Coordinate Systems, then Continental, then North America, then USA Contiguous Albers Equal Area Conic (Figure 8). Back at the Spatial Reference Properties menu, press Apply, and review the transformation parameters in the Details… window. Then, click OK, then OK once more in the Project Raster menu to perform the transformation. The projected raster image will appear in the Table of Contents (far left window) as a layer, with the name

Figure 8: ArcMap GIS Project Raster Dialog / Projection Selection
that you specified. Right-click on the projected dataset layer to review the dataset properties. Check the Raster Information/Cell Size (should be close to 100), Spatial Reference/Linear Unit (should be Meter) and Angular Unit (should be Degree) parameters for accuracy.

6. Create (clip) DEM sub-image exactly matching site boundary

Use the 'point lat/long picker' tool to find the center point corresponding to the Olympic test site coordinates (in decimal degrees) of 47.54 N, 123.58 W. When you find it, note the corresponding coordinates in meters displayed at the bottom of the screen. Write these down. Next, select ArcToolbox feature Spatial Analyst Tools / Extraction / Extract by Circle Specify the raster mosaic just created as the input raster; enter the map unit coordinates that you just 'picked' off the screen as the Center Point. These are: \( x = -2051844 \), \( y = 1443195 \). Enter 50,000 (meters, the 50 kilometer radius in map units) for the radius. Provide an appropriate output raster dataset name, and select INSIDE as the Extraction area (Figure 9). Click OK to perform the extraction. The resulting circular raster sub image is the study area (Figure 10).

Figure 9: ArcMap GIS Extract By Circle Dialog: Creating ‘circular’ Olympic test site
7. Classify site into elevation zones

Next step: generate a classified raster image in which the cell values contain the elevation class to which the corresponding cell in the original raster image belongs. There are two steps: Creating an ASCII classification table, and then using that table to generate the classified elevation zone map.

A. Create site-specific Elevation Zone lookup table  
Having created the digital elevation model for the test site, the next step is to determine the proportions of the site that fall into each of the 100 meter elevation zones. We will use the ArcToolbox 3D Analyst Tools / Raster Reclass / Reclass by ASCII File utility. To do so, we need to create an ASCII input file that specifies the elevation zone ranges or ‘bins’ to use in the classification. For a discussion of the acceptable file formats, For a good introduction to this topic, open ArcMap help, and use the phrase ‘About Remap Tables’ as search criteria. Our table will have the following format:

1 100  
100 800  
800 1000  
1000 1500  
1500 2000  
2000 2100  
2100 2370

Note that the 1 value in the first line, and the 2370 value in the last line, represent the minimum and maximum elevations found in the study area. The minimum and maximum are the High and Low values displayed on the grey scale for the raster image layer legend in the Table of Contents.
Create this table using a text area. Name it 'OlympicElevationClass.asc'. Note that the file will probably be different for each study site, since each site will have different minimum and maximum elevations. Figure 11 shows the elevation class table for the Olympic test site.

B. Start the **Reclass by ASCII File** utility. Choose the clipped raster subimage from Step 5 as the input raster. Select the ASCII remap file **OlympicElevationClass.asc** as the Input ASCII remap file. Select an appropriate name for the output raster file (Figure 12). Click the 'OK' button to perform the classification. The output image is a classified raster in which the raster cell values indicate the elevation class to which that cell belongs (Figure 13).

C. Export the classified DEM image as a .dbf file with the name: **Export_Output.dbf**. To do so, right-click the classified image name, select **Open Attribute Table**, then **Options**, then **Export** (Figure 14). The exported file MUST be called **Export_Output.dbf**. The Elevation Zone Area calculation utility, added to the user interface in Step 1, expects to find this file in the same folder as the rest of the files for the current study site.
Figure 11: Elevation Class Table for Olympic Test Site

<table>
<thead>
<tr>
<th>h</th>
<th>100</th>
<th>100 200</th>
<th>200 300</th>
<th>300 400</th>
<th>400 500</th>
<th>500 600</th>
<th>600 700</th>
<th>700 800</th>
<th>800 900</th>
<th>900 1000</th>
<th>1000 1100</th>
<th>1100 1200</th>
<th>1200 1300</th>
<th>1300 1400</th>
<th>1400 1500</th>
<th>1500 1600</th>
<th>1600 1700</th>
<th>1700 1800</th>
<th>1800 1900</th>
<th>1900 2000</th>
<th>2000 2100</th>
<th>2100 2200</th>
<th>2200 2300</th>
<th>2300 2370</th>
</tr>
</thead>
</table>

For Help, press F1
Figure 12: ArcMap GIS Raster Reclass by ASCII File Utility Dialog
Figure 13: Re-classified Raster DEM: Elevation Classes
8. Tabulate elevation zone area table in report-compatible format

Generate the elevation zone areas using the Elevatrition Zone Area calculation utility that we added to the Spatial Analyst toolkit (toolbar) in Step 1. Highlight the classified DEM image in the ArcMap GIS Table of Contents by left-clicking on the name. To run the utility, left-click the custom user interface tool button on the toolbar. The utility ends by displaying a message box with the zone area file name, which is an ASCII comma separated value file, readable with a text editor or Microsoft Excel.

NOTE: The Elevation Zone Area utility expects that both the ASCII remap file (OlympicElevationClass.asc) and the exported classified DEM image (Export_Ouptut.dbf) will reside in the parent directory of the reclassified DEM image folder (olyrclass). For the current example, these files should reside in the directory C:\Projects\ChristyMcCain\TestSites\Olympics. If not, the utility will fail.
V. Conclusion
The fundamental issues and techniques that comprise this project - spatial data and software tool selection, processing workflow design, quality assurance on ‘production projects’ with multiple study sites – recur on most spatial data processing projects. Therefore, the procedures developed for this project here could be extended and applied to similar spatial data processing requirements on other studies.

Figure 15: Elevation Zone Area Output Table: Olympic Test Site